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for four color printing processes.

Using color in printmaking has always been a challenge. Prints are, generally speaking, images
transferred to paper (or other surfaces) from a freshly inked block or plate. The indirect nature of
this process makes color printing a fairly complex affair requiring careful planning.

Technological advances and innovative thinking have seen better and faster registration methods
for color printing replace older methods across various processes, particularly in plate lithography
and screenprinting. The invention of metal buttons or registration pins [1] has made more accurate
color registration - in stone lithography, especially, much easier to achieve than before. However,
artists practising relief and intaglio processes continued to use older, more time consuming
techniques. Although this has not stop anyone from producing excellent color works, their
production can be tedious. Of the many methods, multi-plate color intaglio may be the most
complex. On the one hand, the thickness and hardness of the metal plate prevented the use of
registration buttons and, on the other, the expansion and contraction of dampened paper hindered
accurate registration.

There are currently four methods for multi-plate color registration used in intaglio [2]:-

1. mount board or mat registration
2. transferring the key-plate image
3. trapped paper registration

4. template registration

Mat, trapped paper and template methods rely on the plates being of identical size, and all being in
exactly the same position each time a print is pulled for the colors to register correctly. In addition,
accuracy of mat registration demands the plates to fit perfectly in the window of the mount board.
Also, in the key-plate transfer process, precision in registration hinges again, precariously, on the
accuracy of the plates’ size and window size. It's easy to see how laborious these methods can be.

By contrast, research into nontoxic intaglio and the introduction of photopolymer films have given
printmakers the opportunity to think in a totally new way. Among these new techniques, Keith
Howard's ImagOn process is perhaps the most advanced and fastest growing. Around 2001
Howard experimented with laminating ImagOn onto PETG (also known as glycolized polyester) and
other polycarbonates, and although, within a short space of time, various research associates and
especially David Jay Reed developed excellent four color methods, the process of printing
remained essentially the same.

In 2004, two graduate students of RIT (Rochester Institute of Technology, NY) Adam Werth and
Justin Myer Staller started experimenting with ways to simplify traditional registration methods. By
replacing copper plates with a clear sheet of thin (0.020 - 0.030 gauge) PETG, they used its
transparency in a totally new way to register plates in the four color process. Instead of positioning
each plate on the press bed then placing paper on top (in the traditional way), after the first plate
was printed in the usual manner, for the second and subsequent printings they used the plates
transparency to enable them to accurately lay down the plate on top of the paper. This new thinking
moved the ImagOn process forward by eliminating various problems; and the lightweight nature of
the plates proved an added advantage when maneuvering large works.

pin registration system for ImagOn on PETG



Looking for Answers

This innovation was perfect for my own four-color projects. My first piece was very small and |
experienced only minor problems. As the pieces got bigger and more complex, with considerable
amounts of text and fine lines, registration became more difficult. One big problem | faced was the
shifting of the plates. Thinner plates minimize the problem to a great extent, but do not fully resolve
it. By using thinner plates and reduced pressure, Werth achieved very good accuracy while Staller,
using thicker ones, was faced with a bigger challenge. Although both achieved a reasonable
degree of success, problems associated with the process make it somewhat unpredictable and
tedious.

Faced with these issues, | went back to the drawing board and began re-examining the whole
process. | felt strongly that of all the possible variables, two had to remain constant: the use of
PETG or polycarbonate plates, and the traditional printing arrangement of having the plate remain
beneath the paper to stop it from shifting during printing.

Once again, | turned my attention to the metal buttons or pins used in the registering of color
screenprints and plate lithographs as a method guaranteed to produce precise results. The
accuracy of the process simply depends on one's ability to register all four transparencies together
and then make holes using a standard hole-punch. It is much easier to register four transparencies
once than to register each plate afresh every time one has to print a color. My challenge was to find
a way to use this method for four color Intaglio Type. The solution was quickly found: the use of thin
PETG in place of copper plates made it possible to punch registration holes with a hole-punch, and
once that was done the rest was simple.

(Takach sell a three hole registration system that suits this method).

Step-by-Step Registration

METHOD
Register and print as follows:

1. Prepare a color image in Adobe Photoshop with a minimum of 100-150mm (4 to 6 inches)
space above the image. The other three sides should have a border at least 24mm (1
inch) wide.

2. Create registration marks on the four corners of the four-color digital halftone file before
splitting the channels.

3. Print each transparency in black ink. For detailed instructions on preparing an image file
for Intaglio Types, see: Process Color Intaglio Type' by David Jay-Reed in Keith Howard's
The Contemporary Printmaker [3]. However, this new registration method does not require
the image files to be manipulated with blur or noise tools while being prepared in
Photoshop.

4. Register all transparencies by laying them over one another and - using the registration
marks as guides - clip or stick them together using large paper clips, small pieces of
double-sided tape etc., to stop them shifting. This is the most crucial step; great care
should be taken to ensure all transparencies are perfectly registered with one another.
Center the clipped pieces properly in a hole-punch and punch two holes at the middle of
the top edge for registration.

5. A few sheets of intaglio printing paper, the same size as the plate, should be calendered
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and dried flat the previous day. For added support, attach clear tape to the edge of the
paper that will be used for registration or use hole strengtheners on both sides. Then
punch registration holes on all sheets of paper in a manner similar to that of the
transparencies.

6. Cut four 3000 to 2000 gauge PETG or Styrene plates to the size of the transparencies.
Center them properly and punch two holes at the top center of each plate in the same way
as on the transparencies.

7. Laminate a piece of ImagOn (large enough for the image) on each plate.

8. Using registration pins, register each transparency to a laminated plate and expose in an
exposure unit.

9. Develop all four plates and ink them using nontoxic Akua intaglio ink.

10. Dampen the printing papers that are already punched with registration holes and dry
between blotters. The paper may buckle slightly underneath the tape, but this should not
create any problems so long as a gap of 100-150mm (4 to 6 inches) is maintained
between the image and registration holes. Register the paper first with the yellow plate by
fixing the registration pins outside to prevent blanket damage. A space of 150mm (6
inches) between registration pins and image will give the roller sufficient room to print the
image. Print the yellow plate; fix the registration pins onto the bed with masking tape.

11. Print the rest of the plates by replacing the first printed plate with each subsequent color
plate. Each time, the paper must be removed from each printed plate and should be
attached into the registration pins of the next plate. Assuming the instruction in step 4
have been followed properly, all colors will register perfectly and printing will be easy.

12. Print an edition or series of variations.

The process is not limited to digital half-tone Intaglio Types. Any hand-prepared
transparencies can be used, provided one follows the correct procedures for each technique.

By reducing the uncertainties of previous methods, this system enables printmakers to enjoy the
printing process and its image-making potential. It should also save valuable time and energy. In
The Contemporary Printmaker [3] Keith Howard writes:

"The evolution of contemporary (nontoxic) intaglio printmaking started in 1991 with my first
book... It became the catalyst for artists from all over the world to re-think and re-invent
printmaking in an unconventional, innovative, and safer manner."

I am happy to be part of this research and particularly pleased to have solved a problem that
plagued me for years and put me off four color intaglio. Using ImagOn with this registration system
has made printing four color intaglio not only viable but also enjoyable.

Notes

1. See LITHCOPRODUCTS for images of these registration pins

2. The Complete Printmaker, The Free Press, Ed., Roundtable Press, revised & expanded 1990
3. The Contemporary Printmaker, Keith Howard, New York: Write-Cross Press, 2003
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4-Color Intaglio-Type
Making Digital Half-Tone Transparency

by Indrani Nayar-Gall

Digital Half-Tone Intaglio-Type

Digital halftone is a way to convert continuous tones of an
image into a random dot pattern. This method enables one to
expose an image on ImagOn without the help of an aquatint
screen. If the final image is exposed at 100% dot structure,
the dots will be so dense that the image will burn out, It is,
therefore, important to carry out tests to find out the correct
density of dot structure.

Indrani Nayar-Gall
Star-Catcher, 2005
4-color photo Intaglio Type
14 x 11 inches

Dot Test

MATERIALS
Products and Equipment needed to make digital half-tone Intaglio-Type:

o Macintosh computer

Epson Stylus high-end printer - preferably 3000/4000/7600
Transparencies

Laminated plates

Platemaking and developing equipment

METHOD
Make digital half-tone Intaglio-Type as follows:

1. Open a new file in Photoshop and name it Dot Test

2. Go to Select menu and scroll All. Make sure the
Foreground/Background icon in the toolbox is set with
Black as the foreground color and White as the
background color.

3. Select Gradient tool and ensure that the Linear gradient is
selected.

4. Press and drag the Gradient tool from the top of the
marquee to the bottom and release.

5. Go to image menu and scroll to Adjustment and select
Posterize in the submenu.

6. Next change the default level 4 in the dialogue box to 20,
click OK. This action will break the gradient into 20 distinct
tonal areas with 100% at the top and 0% at the bottom.

7. Place an Ink Jet transparency in the printer. Select the File
menu and scroll to Print with Preview; check page set up,
then click Print.

8. In the dialogue box scroll to Print Setting and click photo
quality glossy film and select the same in the printer, next
click Advance Setting and change to 1440 dpi, click Black
Ink, Super and then Print.

9. After the transparency is printed, laminate a plate with
ImagOn, expose the transparency to the film once a correct exposure time of the film and
the unit is established, develop and print.

10. The best dot structure is one that has a 75-80% black
dot. Dot structure can be examined with a hand held
microscope.




Enhance your image as follows:

Levels

Channel: RGB 3]

. G —o—3
Before making a transparency it is important to NE— e e
ensure that the depths and highlights of the image
is at the optimum level. This will ensure the Load...
crispness of the tones and will help to create Save..
required intensity of blacks and whites in the R
prints. + Options '
Open the image in Photoshop, the photograph will Ot Laisizs: 6 255
look a bit faded. — AAF
Go to the Image menu and scroll to Adjustments.  Preview

Select Levels in the submenu.

When the dialogue box appears move the left slider (black) to the right until it is just inside
the large hump. Next, move the right slider (white) to the left, until it just inside the hump
this will darken the blacks and soften the whites. Now move the gamma slider (gray) to the
right until the input reads 0.80 in the input box to darken the midtones slightly.

Now to adjust the midtones go to Image menu and surves

scroll to Curves in the submenu. Make sure the - Channel: | RGB R € o)
dark end of the tone bar is at the bottom left. Click A

the middle of the diagonal line to move it back e
slightly. Then click on the line, near the top, and (_Load.. )
near the bottom. Move both points slightly higher L
by clicking one at a time. This will create a gently s Fr—r
M- curve in the diagonal line.

o The next step is to sharpen the whole image just a e
little. To do this go to the Filter menu, scroll down to
Sharpen and then select and click Unsharp Mask Input: |63
in the submenu. Output: [g6 i Preview
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Open the image in Photoshop, scroll to Image size and ensure that the resolution is at
least 150-300dpi.

. Convert the image mode to CYMK and ensure that the Info palette is open.
. Choosing the Color Sampler Tool select one channel at a time and look for the darkest

area of each channel.

. After the darkest channel has been identified, deselect all other channels.
. Go to Image scroll to Adjustment and select Levels. In the Levels dialogue box slide right

whit slider to the left until only a little amount of black remains. This black represents the
darkest area of the image. Remember the area; click cancel in the levels dialogue box.

. With the Color Sampler Tool go back to the darkest area and click the Sampler tool on it. A

sample icon will appear with #1 in the image area.

. Click on the top CMYK channel to select all the channels again.
. Select Adjustment from the image menu and then Levels. In the dialogue box, using Info

palette drag the left slider of the Levels dialogue box until the #1K on the Info palette until
the desired level for the specific transparency is achieved. Click OK.

. To apply registration marks at four corners of the image - go to Image Adjustments, scroll

down and select Canvas Size and increase the canvas size an inch on all four sides. A
border will appear around the image. Using the rectangular marquee tool create a
parameter around the image ensuring that it is equidistant on all sides from the image. Go
to EDIT select the stroke and change the weight to 2px. This command will drop a border
all around the image. Keep the border at 4 corners and erase the rest. Discard layers, if
any, save the image in Tiff format. You now need to split the channels to create four
documents. Press on the arrow in the top right corner of the Channels palette and select
Split Channels in the drop menu. The channels will appear in separate documents with
registration marks and their respective names.

. Place an Ink Jet transparency in the printer. In Adobe Photoshop, select the File menu and

scroll to Page Setup. Make sure Paper Size and Orientation is appropriate in the dialogue
box.

Set the resolution to 1440dpi. Set the media type to Photo Quality Glossy Film or
equivalent, Super and the Ink setting to Black.

Press the Print button.

After all the transparencies are printed carry out a step test to find the correct exposure.



All four plates are then exposed, developed and printed. (Follow instructions given in the
article PERFECT REGISTRATION for applying registration marks, exposing and printing).

The 4-color Intaglio-Type process and making of digital half-tone transparencies was originally developed by David
Jay Reed during his years at RIT. The method described above contains the core concept of his process together
with my own changes and adjustments to make it suitable for my process with registration pins.
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Indrani Nayar-Gall

Indrani Gall has been actively engaged in the field of printmaking as an artist and educator for
many years. In 2005 she furthered her studies in contemporary nontoxic Printmaking at Rochester
Institute of Technology. Her innovations have advanced the 4-color process, making it more
accessible with the use of simpler technology, an easier registration process, and other innovative
color processes. She introduced nontoxic practices to the printmaking department of Barbados
Community College (area coordinator) in 2002. She currently teaches Foundation drawing and
printmaking courses as a part-time faculty at Western Michigan University. She has been
instrumental in introducing 'green’ Intaglio printmaking processes at WMU.

To contact the artist Email: indranigall@yahoo.com

Indrani Nayar-Gall

Anatomy Lesson with Warp Tool, 2006

Monoprint: Intaglio Type, Chine Colle and drawing
13.25 x 16 inches
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Indrani Nayar-Gall

Through the Looking Glass I, 2006
Intaglio Type and Graphite

14.5 x 18 inches

Indrani Nayar-Gall

Alice and the Worlds I, 2006
Construction: Intaglio Type and Graphite
13.75 x 18.25 inches



Indrani Nayar-Gall

Alice and the Worlds IIl, 2006
Construction: Intaglio Type and Graphite
17.5 x 22 inches



Indrani Nayar-Gall

Conversation Ill, 2006

Unique print: Intaglio Type, Chine Colle, Hand Stitching, Collage, Graphite
25.2 x 11.25 inches



Indrani Nayar-Gall

Deities-Demons 1, 2006

Assemblage: Spit Bite Intaglio Type, Graphite, Plastic Figurine
42 x 27 inches



Indrani Nayar-Gall

Deities-Demons I, 2007

Assemblage: Spit Bite Intaglio Type, Hand Coloring, Plastic Figurine
42 x 70 inches

All images are the copyright of the artist.
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